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About this Product

For The Device Set-up, installing the plug-ins allows you to obtain the infor-

mation of a copier on the network and/or change its settings.
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Trademarks

KONICA MINOLTA, the KONICA MINOLTA logo and PageScope are either 

registered trademarks or trademarks of KONICA MINOLTA, INC.

Active Directory, Microsoft and Windows are either registered trademarks or 

trademarks of Microsoft Corporation in the United States and/or other coun-

tries.

Intel and Pentium are trademarks or registered trademarks of Intel Corpora-

tion or its subsidiaries in the United States and other countries. 

Microsoft® and Windows® are either registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.

All other product names are trademarks or registered trademarks of their re-

spective companies.

Dialog boxes

2
Note 

The dialog boxes that appear in this document may differ from those that 

appear on your PC, depending on the installed devices, specified set-

tings, and PC that you are using.

2
Note 

Unauthorized reproduction, translation or duplication of this document, 

whether in its entirety or in part, is strictly prohibited.

The content of this document is subject to change without notice.

Copyright © 2007 KONICA MINOLTA, INC. All rights reserved.
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Getting Started 1
1 Getting Started

1.1 System Requirements

Systems must have the following specifications in order to use this software.

Refer to the Readme file for the latest information about the operating envi-

ronment.

Operating System Windows Vista Enterprise (SP2 or later)*
Windows Vista Business (SP2 or later)*
Windows Vista Ultimate (SP2 or later)*

Windows 7 Enterprise (SP1 or later)*
Windows 7 Professional (SP1 or later)*
Windows 7 Ultimate (SP1 or later)*

Windows 8.1 Pro *
Windows 8.1 Enterprise *
Windows 10 Pro *

Windows 10 Enterprise *
Windows 10 Education *
* 32-bit(x86) and 64-bit(x64) editions are supported.

Computer According to the recommended system requirements of your operating 
system.

Memory (RAM) According to the recommended system requirements of your operating 

system.

Unused hard drive 

capacity

100 MB or more

Display 800 × 600 pixel, 16 bit - color or better

Network TCP/IP protocol

Web browser Microsoft Internet Explorer
The latest version supported by each OS.

Libraries Microsoft .NET Framework: Both of the following versions are required.

• .NET Framework 3.5 (SP1 or later)
• .NET Framework 4.5 or later
* If you are using Windows 8.1 or Windows 10, install .NET Framework 

3.5 separately with the following procedures.
1. Open [Control Panel], and then click [Programs] - [Programs and Fea-
tures] - [Turn Windows features on or off].

2. Select the “.NET Framework 3.5 (includes .NET 2.0 and 3.0)” check 
box, and click [OK].
3. Complete the installation according to the instructions shown.

Supported Devices For details of the copier and the printer (supported device of the plug-in 
application), see the Readme of each plug-in application.
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2
Note 

In order to use this software, it is necessary to enable OpenAPI from the 

device panel by selecting Administration Settings, then System.

1.2 Overview of Functions

For The Device Set-up, installing the following plug-ins allows you to obtain 

the information of a copier on the network and/or change its settings.

Plug-in Description

PageScope 

Data Administrator

PageScope Data Administrator is an administration tool with 

which authentication data and addresses that are registered in 
the control panel of supported devices (multifunctional OA 
equipment) can be edited and changed from other computers 

on the network.

HDD Backup Utility HDD Backup Utility is used to back up (save) and restore (re-
cover) information on media installed in multifunctional prod-

ucts (MFP) on the network.

Log Management Utility Log Management Utility accesses MFP products on the net-
work, and displays log files (operations and processing 

records that include monitoring logs and communications his-
tory) stored on these devices. These can be used in manage-
ment of device usage status, and in troubleshooting. 

Font Management Utility Font Management Utility is a utility that allows you to add and 
delete the fonts and the forms for printing of the supported de-
vices (MFPs) that are on a network.

Copy Protection Utility Copy Protection Utility is used to program multifunctional 
products with copy protection and stamp information.
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2 Software Installation

2.1 OpenAPI settings

Some plug-in applications use OpenAPI. On an occasion like this, it is nec-

essary to make a write setting in advance on the device side.

Installation procedure

Before installing the Device Set-Up, specify the OpenAPI settings on the de-

vice.

% Specify the OpenAPI Login Name and password from the control panel 

of the device as necessary.

– For details on the procedure for specifying the OpenAPI settings 

from the control panel of the device, refer to the device’s User’s 

Guide.

2
Note 

Follow the instructions in the User’s Guide for the device to specify the 

settings for SSL transmission.
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2.2 Installation of Device Set-Up

Install the Device Set-Up as follows:

2
Note 

When installing the Device Set-Up, the Microsoft .NET Framework is re-

quired to have been installed in advance.

The version of Microsoft .NET Framework is based on the OS to be used. 

Refer to page 1-1 for details. 

Before installing the utility, be sure to log in with Administrator privileges.

Quit all applications (including virus detection programs) that are running.

Installation

1 Double-click the Setup.exe of the plug-in application you want to in-

stall.

2 Select language and click [OK].

3 Before installing the plug-in application, a message is displayed in-

forming that the Device Set-Up will be installed. When the message is 

displayed, click [OK].
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Software Installation 2
4 Click [Next].

5 When you consent to the Software End User License Agreement, se-

lect [I accept the terms in the license agreement] and then click [Next].

– When you do not consent to the Software End User License Agree-

ment, you cannot use this software.
Device Set-Up 2-3



Software Installation 2
6 Specify a folder into which it is installed, and click [Next].

– When changing the location into which an installation is made, click 

[Change] to specify the location into which it is installed.

– When no change is made to the location into which an installation 

is made, an installation is made into the C:\Program Files\KONICA 

MINOLTA\PageScope Data Administrator V4 folder.

7 Select setup type and then click [Next].

– When selecting [Complete], all program features will be installed.

– When selecting [Custom], select which program features you want 

installed and where they will be installed.
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8 Click [Install].

– When specifying [Create a Shortcut on the Desktop], shortcut is 

created on the desktop.

9 Click [Finish].

The installation is completed.

In addition, install the plug-in application.

For details of the procedure for installation of the plug-in application, 

see respective User’s Guides.
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2.3 Uninstalling

The uninstallation method of Device Set-Up is as follows.

- Using “Programs and Features” in “Control Panel” 

2
Note 

Before uninstalling, quit the Device Set-Up.
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3 How to Use the Device Set-Up

The following procedure describes how to specify the necessary settings 

when the Device Set-Up is first started.

3.1 Specifying automatic protection settings

In order to prevent unauthorized use of the application, an access password 

and timeout time can be specified. If the length of time that no operation is 

performed in this utility exceeds the specified timeout time, the application 

is automatically locked. The application can be unlocked if the access pass-

word is entered.

Installation procedure

1 From the Windows Start menu, start the Device Set-Up.

– Click the Windows [Start] - [All Programs] - [KONICA MINOLTA] - 

[Device Set-Up] - [Device Set-Up].

The Application protect settings dialog box appears.

2 Select [Use auto protect].

3 To use automatic protection, specify the [Timeout Period] and the 

[Password].

– After the first time that the utility is started, this dialog box does not 

appear. Instead, the main window appears.
Device Set-Up 3-1



How to Use the Device Set-Up 3
4 Click [OK].

The automatic protection settings are applied, and the main window 

appears.
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To change settings

Automatic protection settings can be changed using the menu above the 

main window.

1 Click [Tool] from menu and select [Option] - [General].

2 Select [Auto protect] in [Target of setting] field.

3 Change the Auto protect settings, and then click [OK].

– To turn off automatic protection, clear the check box.

– To change the timeout time, click [Change Timeout Period], and 

then change the setting.

– To change the access password, click [Change password], and 

then change the password.

The changes are applied to the settings, and the main window appears.
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3.2 Main Window

When the Device Set-up is started, the Main window is displayed.

2
Note 

The screen above shows the condition in which individual plug-ins are in-

stalled. The screen displayed may vary depending on a plug-in installed.

For the Device Set-up, the operations such as search, registration and 

edit of a copier (supported device) on the network are conducted through 

this screen. 

For other functions, it is necessary to install each particular plug-in. For 

detailed functions of individual plug-ins, refer to the respective user’s 

guides.
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Menu Bar

Menu Explanation

File Device List The import/export of the Device list is made.

Exit Close the application.

Function Edit Copy Protect/Stamp This can be used when the Copy Protection 

Utility plug-in is installed.

Font/Form This can be used when the Font Management 
Utility plug-in is installed.

HDD Backup This can be used when the HDD Backup Utility 
plug-in is installed.

Restore This can be used when the HDD Backup Utility 

plug-in is installed.

Log Viewer This can be used when the Log Management 
Utility plug-in is installed.

Receive Log This can be used when the Log Management 
Utility plug-in is installed.

Authentication Settings/Address 
settings

This can be used when the PageScope Data 
Administrator plug-in is installed.

Administrator settings This can be used when the PageScope Data 

Administrator plug-in is installed.

Settings for multiple devices Individual functions are collectively handled.

Log This can be used when the Log Management 

Utility plug-in is installed.

Application initial setting The files set are saved locally with no connec-
tion made to the device.

Tool Option The optional functions of each plug-in are set.

Device Registration of 
Device

Start device registration.

Edit registered 
group

Start group settings.

Network initial 

setting

Configure default settings for the registered de-

vice network.

LDAP server settings Configure LDAP server settings.

Function ac-

cess restric-
tion

New Create a function access restriction file.

Open Open an existing function access restriction 
file.
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Icon / Tab in main window

Window Display Top screen dis-
play

Top screen is displayed.

Access history 
display

The screen for the access history display is dis-
played.

Cascade view Display screens cascaded inside the main win-

dow.

Tile Horizontal Display screens inside the main window tiled 
horizontally.

Tile Vertical Display screens inside the main window tiled 
vertically.

Help Help Display Help.

Version information Display the version of Device Set-Up.

Icon / Tab Explanation

The screen registered as a top screen is displayed.

The registration of the Device is started.

The network of the registered device is initialized.

Basic Settings tab The Device list is displayed. It is also possible to select a function 

from [Function Selection] to the right of the screen.

Settings for multiple 
devices tab

Individual functions are collectively processed. The display may 
vary depending on a plug-in installed.

Log tab The log management is made. For this operation, the Log Man-
agement Utility is required to be installed in advance.

Application initial set-

ting tab

The files set are saved locally with no connection made to the de-

vice.

Function Selection It is possible to select a function that can be used.
The Device Selection Filter allows you also to list up devices that 

are provided with supported functions.

Menu Explanation
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4 Device Registration

The Device Set-up allows you to search and register a supported device on 

the network. For the supported device registered, various settings can be 

made for each plug-in.

4.1 Search for a supported device

As a method for the search/registration of a supported device, the following 

are available.

- Method for searching a supported device on the network

- Method for searching a supported device with the IP address specified.

- Method for registering a supported device from the Function access re-

striction file

- Method for registering a local file

!
Detail 

When making a search for a device on the network, it is also possible to 

set the range of search.

Register Found Devices

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Click .
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3 Click [Search and Register].

Device Search Result list appears.

4 Select the devices to register and click [Select].

– When a search for a device is made again, click [Re-search].

5 Click [OK].
Device Set-Up 4-2



Device Registration 4
6 When the administrator password of the device is required to be en-

tered, enter the password and then click [OK].

7 Click [Close] in Result of Registration Processing window.

8 Click [Close].

The devices are registered.

2
Note 

It sometimes takes more than two minutes before the device registered 

is displayed in the Device list on the main window.

When the device cannot be searched:

There is a possibility that this is not set as “Exceptions program” while in 

the setting of the firewall. Set this application as “Exceptions program” 

while in the setting of the firewall for the network setting of the PC.
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Registration with the IP address specified

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Click .

3 Click [Add].
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4 Enter the IP address in [Device address] text box and click [OK].

5 Check the contents in Edit device information window and click [OK].

6 Click [Close].

The devices are registered.

2
Note 

It sometimes takes more than two minutes before the device registered 

is displayed in the Device list on the main window.
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Registration from the Function access restriction file

It is possible to register a supported device from the Function access restric-

tion file that has been written in advance. For details of the creation of the 

Function access restriction file, refer to page 5-11.

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Click .

3 Click [Register from function access restriction file].

4 Select “Function access restriction file” and click [Open].
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5 Enter the decryption password and click [OK].

6 When the release confirmation screen of the access restriction is dis-

played, click [Yes].

7 Enter the password and click [OK].

8 Select device to import by clicking [Select] and click [Next].
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9 Click [Import].

10 Click [OK].

The devices are registered.

2
Note 

It sometimes takes more than two minutes before the device registered 

is displayed in the Device list on the main window.
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Registration of the local file

The setting information created in the local file is registered with no connec-

tion made to the device.

0 When registering a local file, the PageScope Data Administrator is re-

quired to have been installed in advance.

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Click [Application initial setting] tab and select [Register a Local file].

3 Click [New].
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– When reading a backup file, select [Import from the backup file], 

click [Browse] and then specify the backup file.

4 Click [OK].

5 Enter all informations and click [OK].

6 When a device is selected that requires option setting, specify option 

setting and click [OK].

7 When the confirmation message is displayed, click [OK].

The devices are registered.
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2
Note 

It sometimes takes more than two minutes before the device registered 

is displayed in the Device list on the main window.

Set the search range

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Click .

3 Click [Search and Register].

Device Search Result list appears.
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4 Click [Search settings].

– Details settings:

For a device search, specify the priority in registering the device ad-

dress. The priority thus specified here is applicable when the device 

address is updated in [Update Device Address].

5 Click [Add].

– When a change is made to the search settings that have been reg-

istered, click [Edit].

– When deleting the search settings that have been registered, click 

[Delete].
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6 Select search method and click [OK].

7 After setting the IP address, subnet mask, port No. and SNMP V1/V2/

V3 of the search range, click [OK].

8 Select the search settings to be added and click [Close].

The search settings are set.

– When a search is made with the search settings that have been set, 

click [Re-search].
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Edit of the device registered

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Click .

3 Select the device to edit from the list and click [Edit].
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4 Change setting and click [OK].

The registration information is edited.
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Delete of the device registered

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Click .

3 Select the device to delete from the list and click [Delete].
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4 When the confirmation message is displayed, click [OK].

The registration information is deleted.
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5 Other Functions

For the Device Set-up, the setting of the following can be made other than 

the registration of the supported device.

- Network Initial Setting

- Import/Export of device list

- Group setting

- The setting of function access restriction file

- LDAP server settings

- Options settings

5.1 Network Initial Setting

Search a device on the network and then initialize the network.

Initialize the network of the Device

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Click .

– When the search range of the Device is not yet set, click [Search 

settings] to add the search range. For details of the search range 

setting, refer to page 4-11.

– A search for devices is started. And devices that have been 

searched are displayed in the list of the network initialization 

screen.
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3 Select devices from the list for which to configure network default set-

tings, and click [Network Settings].

4 Set required items, and click [Change settings].

– Device Information:

Displays currently set device Model name, IP address, and MAC 

address settings.

– Device Name (sysName): Input the device name.

– Location (sysLocation):

Input the location where the device is installed.

– Obtain IP Address automatically:

Select this to have the device IP address automatically set by the 

DHCP server.
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– Set IP Address manually:

Select this to enable the following text boxes, enabling specifica-

tion of device IP addresses.

– IP address: Input the IP address of the device.

– Subnet Mask: Input the Subnet mask of the device.

– Default Gateway: Input the default gateway of the device.

5 When the confirmation message is displayed, click [Yes].

6 Click [OK].

7 Click [OK].
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8 Click [Close].

!
Detail 

Configuring network default settings in itself does not allow administra-

tion of devices using Device Set-Up. In order to administrator devices, 

first register them with Device Set-Up. For details, please refer to “Device 

Registration” on page 4-1.
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5.2 Export/Import of the Device list

For the Device Set-up, it is possible to import/export the Device list.

Export of the device list

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Device list] - [Export] from the [File] menu.

3 Enter the name of a file to be exported, specify a location into which 

the file is saved and then click [Save].

4 Select the device to export from the list and click [Select].

5 Click [Next].
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6 Enter the Encryption password and click [Finished].

7 When the confirmation message is displayed, click [OK].

The Device list is exported. (Extension: psa)
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Import of the device list

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Device list] - [Import] from the [File] menu.

3 Select the file to import and click [Open].

4 Enter the Decryption password and click [OK].

5 Select the device to import from the list and click [Select].

6 Click [Next].

7 Click [Import].

– When [Connection OK] is not displayed, click [Update].
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8 When the confirmation message is displayed, click [OK].

The Device list is imported.
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Import of the Device list from the previous version

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Device list] - [Import from previous version] from the [File] menu 

and select the tool of one of the old versions as shown below.

– Copy Protection Utility

– Font Management Utility

– HDD Backup Utility

– Log Management Utility

– PageScope Data Administrator

3 Select the device to import from the list and click [Select].

4 Click [Next].
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5 Click [Import].

– Clicking [Update] updates the condition of the Device list.

– Clicking [Stop] stops updating the condition of the Device list.

The reading of the condition of the Device list into Device lists is 

made only for those in the [Connection OK] status.

The device list of the previous version is read.
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5.3 Function Access Restriction File Settings

Register a device in a function access restriction file. Use of a function ac-

cess restriction file means that some device functions (address settings, etc.) 

can be configured without the input of an administrator password.

Create a New Function Access Restriction File

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Function access restriction] - [New] from the [Tool] menu.

3 Select the device to set the function access restriction file from the list 

and click [Select].

4 Click [OK].
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5 Configure the function access restriction file, and click [OK].

– Authentication setting: 

Select this to allow access to authentication settings.

– Address settings: Select this to allow access to address settings.

– Administrator settings: 

Select this to allow access to administrator settings.

6 Click [Name and Save], specify the location into which the file is saved, 

and then click [Save].

7 Set the Encryption password and Editing password, and click [OK].
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– Encryption password: 

Input the password to use to open the function access restriction 

file.

– Encryption password (Confirmation): 

Retype the password for confirmation.

– Editing password: 

Input the editing password to use to edit the function access re-

striction file.

– Editing password (Confirmation): 

Retype the editing password for confirmation.

8 Click [OK].

The function access restriction file is saved.

!
Detail 

Refer to p. 4-6 for more information about registration from function ac-

cess restriction file.
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Add a Device to a Function Access Restriction File

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Function access restriction] - [Open] from the [Tool] menu.

3 Select the function access restriction file to add a device and click 

[Open].

4 Enter the Decryption password, Editing password and click [OK].

5 Click [Select Device].

6 Select the device to add from the list and click [Select], and click [OK].
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7 Click [Close].

– Click [Edit] to set the function access restriction file as necessary

8 Click [Name and Save].

The function access restriction file device is added.
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Edit the Function Access Restriction File

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Function access restriction] - [Open] from the [Tool] menu.

3 Select the function access restriction file to edit and click [Open].

4 Enter the Decryption password, Editing password and click [OK].

5 Select the device to edit and click [Edit].

6 Configure the function access restriction file, and click [OK].

7 Click [Name and Save].

The function access restriction file is edited.
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Delete the device information from a Function Access Restriction File

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Function access restriction] - [Open] from the [Tool] menu.

3 Select the function access restriction file to delete and click [Open].

4 Enter the Decryption password, Editing password and click [OK].

5 Click [Delete].

6 When the confirmation message is displayed, click [Yes].

The device information is deleted from a function access restriction file.

7 Click [Name and Save], specify the location into which the file is saved, 

and then click [Save].

The function access restriction file is saved.
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5.4 Group Settings

Register groups to be managed in Device Set-Up. If groups are configured 

and many devices are being managed, sorting the device list makes arrang-

ing items easier. Additionally, up to a maximum of 100 groups can be set.

Create a New Group

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Device] - [Edit registered group] from the [Tool] menu.

3 Click [New].

4 Set the Group name, and click [OK].

A group is created. 

5 Click [Close].
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Edit a Group

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Device] - [Edit registered group] from the [Tool] menu.

3 Select a group to edit from the list and click [Edit].

4 Change the Group name, and click [OK].

A group is edited. 

5 Click [Close].
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Delete a Group

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Device] - [Edit registered group] from the [Tool] menu.

3 Select a group to delete from the list and click [Delete].

4 When the confirmation message is displayed, click [Yes].

The group is deleted.

5 Click [Close].
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Set the Default Group

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Device] - [Edit registered group] from the [Tool] menu.

3 Select a group to make default from the list, and click [Set Default].

– The default group is indicated with a “*.”

4 Click [Close].

!
Detail 

The default group is indicated with a “*.”

The default group is the initial group displayed when registering a device.
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5.5 LDAP Server Access Settings

Register the LDAP server that reads the information to register on a device.

Add LDAP Server Access Settings

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [LDAP server settings] from the [Tool] menu.

3 Click [Add].

4 Set LDAP server access settings, and click [OK]. 
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– When Anonymous is selected

– When Simple is selected
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– When NTLM is selected

– Directory name: Input a name for the current details.

– LDAP server address: 

Input the IP address or DNS name of the directory server. If using 

SSL, input the DNS name.

– Search Base: 

Input the search base. (Up to 512 characters)

(E.g.) ou=sales division, dc=ABCDEFG, dc=com

Consult with the LDAP administrator about search bases to input.

– Port Number: 

Specify the port number to be used when accessing LDAP servers.

– SSL: Select when using SSL for LDAP communications.

It is recommended that you use SSL for secure transmission. Not 

using SSL means that LDAP data will be transmitted over the net-

work in unsafe ASCII format.

– Search maximum number: 

Specify the maximum number of items to show when searching.

– Timeout settings: Specify the transmission timeout for the LDAP 

server. (1-120 sec)

– Authentication Settings (Anonymous, Simple, NTLM): 

Select the bind type for the LDAP server. Select NTLM when con-

necting to an Active Directory.

– Domain name: Input the domain name.

Input Domain Name when connecting to an Active Directory.

– User Name: 

This field can be entered when authentication is not set to Anony-

mous.

– Password: 

This field can be entered when authentication is not set to Anony-

mous.

– Password (Confirmation): Re-input password for confirmation.
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5 Click [OK].

The LDAP server access settings are added.

Edit LDAP Server Access Settings

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [LDAP server settings] from the [Tool] menu.

3 Select access settings to edit from the list, and click [Edit].

4 Edit LDAP Server Access Settings, and click [OK]. 

The LDAP server access settings are edited.

!
Detail 

Refer to p. 5-22 for more information about LDAP server setting.

Delete LDAP Server Access Settings

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [LDAP server settings] from the [Tool] menu.

3 Select access settings to delete from the list, and click [Delete].

4 When the confirmation message is displayed, click [Yes].

The LDAP server access settings are deleted.
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5.6 Display Option Settings 

Set items to display in lists such as registered device lists, etc. 

Set Display Options 

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Option] - [General] from the [Tool] menu.

Options in general window appears.

– When selecting [General] in the Target of setting area with [When 

minimized, display only on task tray] checked, the display is made 

only on the task tray while in the minimized display.

– To update the Device list periodically, check [Update device list pe-

riodically.], and then specify [Update Interval].

– Refer to p. 3-1 for more information about Auto protect.
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– Selecting [Display column of the Device List] in the Target of setting 

area allows you to select an item to be displayed in the main win-

dow.

– Device List Header Display Column: 

Check an item you want to display.

– Up: Move the selected items up. 

– Down: Move the selected items down. 

– Selecting [Function Selection Display Order] in the Target of setting 

area allows you to select an item to be displayed in the Function Se-

lection area of the main window.

– Up: Move the selected items up. 

– Down: Move the selected items down. 

3 Set display options, and click [OK]. 
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!
Detail 

The settings of the Function Selection Display Order are made valid only 

after restart.
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5.7 Displaying the Help

From the help menu, it is possible to display the online help of the Device 

Set-up and the individual plug-ins.

Displaying the Help

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Help] - [Device Set-Up Help] from the [Help] menu.

It is also possible to display the help information of the individual plug-

ins that have been installed.

– Device Set-Up Help

– Copy Protection Utility Help

– Font Management Utility Help

– HDD Backup Utility Help

– Log Management Utility Help

– PageScope Data Administrator Help
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5.8 Displaying the version information

The version information for the Device Set-Up can be displayed.

Procedure

1 Start the Device Set-Up to display main window.

– For details of the method for displaying the main window, refer to 

page 3-1.

2 Select [Help] - [Version information] from the [Help] menu.

3 Confirm the version.

!
Detail 

When checking the version of the individual plug-ins that have been in-

stalled, click [Plug-in version].
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